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  Welcome to another issue of Full Circle Magazine.


  This month, we have a new series for you: How To Program In C. C is surely King of programming languages. If you want to program in the most widely used, and most respected, language, then this new series is definitely for you. Also, we have an extra-long 'My Story' from David Rowell, giving us his timeline from Fortran punch-cards to his current Ubuntu usage (morse-code anyone?). And a few other small cosmetic changes within the magazine.

  

  Many people have asked about PDF files containing an entire series. We (myself and some others on the forum) are in the process of compiling a PDF of my Scribus tutorials and, once we get that done, we will create a PDF of the Create Your Own Server series. So look out for those coming soon. Our IRC channel has become rather quiet lately (understatement of the year!) so, to try to get you good folks on IRC, we are publishing a How-To on connecting to IRC. Not only is this to get people in our channel, but it is also the best, and quickest, way to get help when you have a question about either Ubuntu, or an app. So please take the time to learn IRC; it's like having a 24hr help desk at your disposal. And don't forget to visit the Full Circle channel where you can have your say on what you like (or dislike) about the magazine.

  

  All the best,

  

  Ronnie

  Editor, Full Circle Magazine

  ronnie@fullcirclemagazine.org


  

  



  Command & Conquer


  Written by Robert Clipsham


  If you've been following the tutorials so far, you should now know the basics of staying safe, and managing files at a command line. This month we show you how to edit files using Nano and Vi/Vim.

  

  To get started, I'll show you the easier of the two editors to use, Nano
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  At the top you will see three things. On the left 'GNU Nano' followed by a version number, in the center the name of the file, and on the right the status of the file. At the bottom, there are two rows of commands for the editor, then a status row just above them. To edit the file, just start typing like you would with any other text editor!

  

  Other than editing the file, the common functions (and their key combinations) are listed at the bottom. For example, ^O (Ctrl+O) will 'WriteOut' or save the file, and ^W (Ctrl+w) will allow you to search for a certain term in the file. Enter some text into the file, then save it. Nano is the easier of the two editors to use, but its functionality is much less than that of Vi or Vim.

  

  By default, Ubuntu comes only with the basic Vim package, without all the bells and whistles. This is fine for this tutorial, but for advanced editing, you'll need the full package (we'll show you how to get this using a command line in the next tutorial).

  

  Text editors do two main things: edit files and automate tasks. The tasks could be anything from find/replace to just saving a file. In graphical editors, the latter is done by using menus or clicking buttons. In Nano, you use certain key combinations to perform these tasks. Vim has two modes for this functionality: an insert mode and a command mode. Vim (below) starts in command mode by default, so you won't be able to edit the document.
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  To switch to insert mode, press 'i' or the insert key. You will now be able to edit the file. Enter a few lines of extra text, then switch back to command mode by pressing the escape (esc) key. There are a hundreds, if not thousands of commands in vim, providing a lot of functions. Some of the basic commands are shown below.

  



  
    
      
        	Command

        	Function
      


      
        	:w

        	Save the document.
      


      
        	:q

        	Quit Vim.
      


      
        	:q!

        	Quit Vim without Saving
      


      
        	h,j,k,l

        	Move around document, you can also use the arrow keys
      


      
        	:e [filename]

        	Open the given file.
      


      
        	:help [command]

        	Open the main help page or get specific help
      


      
        	:set [option] [value]

        	Get a list of options that have been set, or set an option
      

    
  


  So, for example, if you wanted to save your changes, type ':w' (all of vim's command start with ':'). You can also mix commands, so for example ':wq' saves and quits vim.

  

  These are just a few of the basic commands Vim has. There are also commands for copy/paste, find and replace, syntax highlighting, showing line numbers, and more advanced functions too. If you want more information, use :help or read the documentation at http://www.vim.org/docs.php.

  

  Robert Clipsham is a self-confessed geek, whose hobbies include: programming/scripting, chatting on IRC and not writing his articles on time.

  



  How To

  Program In C - Part 1


  Written by Elie De Brauwer


  This article is the first in a series which will focus on having fun with the C programming language. In the first articles, we will introduce the C language and some basic computer programming concepts to the novice user. This way, inexperienced users should be able to follow the series, and get to a level where they should be able to write and understand simple C applications. Once the basics of the language are explained, we will introduce new concepts, techniques, and more intermediate-to-advanced principles -- by example. I hereby promise I will do my best not to make too-large leaps, and to introduce new concepts as we encounter them. If any reader experiences problems, or fails to properly understand certain things, please do not hesitate to get in touch with me.

  

  Why C ?

  

  Today, there are numerous programming languages out there, and the question of why to use 'A' and not 'B' has led to never-ending discussions. A first argument is that C is still a very popular language. A second argument is the link between UNIX and C -- C was initially developed at AT&T Bell Labs between 1969 and 1973 by Dennis Ritchie, and the UNIX kernel was the first major project to be implemented in the language. Nowadays, the number of (open) software projects written in C is still huge -- the best known is probably the Linux kernel itself. The main objections against learning C are that it is not a modern language; for example, it lacks a rich framework, and it is not object-oriented, which makes C a rather simple language to learn. On the other hand, a valid objection is that, since C is a language closely related to the hardware, it can allow users to do things that were not supposed to be done. If you really want to shoot yourself in the foot, C will not prevent you from doing so.

  

  Preparing your system

  

  Now, the scary part -- it's time to get our hands dirty. If you visit a programming-related forum or newsgroup, you will encounter, at regular intervals, somebody who wants to start programming and fails to compile/execute the first example they found on a website (or in a magazine). Especially for those beginning programmers, Debian/Ubuntu has foreseen this, and provided a special metapackage called 'build-essential`. Running:

  

  sudo apt-get install build-essential

  

  will equip your system with everything required to compile a simple C application (amongst others the GNU GCC compiler and make). In this series, we won't teach you how to use an IDE (Integrated Development Environment — a graphical suite that performs embedded debugging, editing, building, and includes, preferably, some content help for the user as well). There are some excellent IDEs available, such as Anjuta, KDevelop, Code::Blocks, and Eclipse in conjunction with the CDT. You are, of course, free to use any of those, but I suggest you learn programming using your favorite text editor such as Emacs, Vi, Vim, Kate, and numerous others. Simply pick an editor that supports syntax highlighting for C (most editors should have this feature). And, next to your favorite editor, make use of a terminal emulator to type in some commands. Once you master these steps, and know what's going on under the hood, you can still switch to an IDE, or not. I write all my code using Emacs and some x-terminals.

  

  Hello World

  

  Enough talk. The simplest application (which actually does something), and the de facto first example for every programming language, is the so-called 'hello world' application. This is an application which starts up, displays the string 'Hello world', and terminates. This code can be seen in Listing 1.


  
    01. #include <stdio.h>

    02.

    03. /***********************************

    04. * Main function gets called when *

    05. * the application is launched *

    06. ***********************************/

    07. int main()

    08. {

    09.  // Say something to the audience

    10.  printf("Hello world\n");

    11.  return 0;

    12. }

    

    Listing 1
  


  To compile and execute this application, put it in a text file with the extension .c, open a terminal, go to the directory where you saved the file, and execute:

  

  gcc -Wall -W -Werror hello-world.c -o hello-world

  ./hello-world

  

  Hello world

  echo $?

  

  0

  

  The first line will invoke the GNU C compiler to compile the file called hello-world.c and output (-o) it to an executable called hello-world. The options *-Wall -W and -Werror instruct the compiler to check for warnings (a warning is a non-critical error, meaning the compilation will still succeed but it might not do what the user expected in all situations), and abort when a warning is encountered. We execute the binary by prefixing it with './' -- this is because the directory where you placed the binary will typically not be in your $PATH. And we used the funny echo command to inform us of the exit status of the last command executed. It is not a coincidence that this value is the same as the value after the 'return' statement. Now, let's take a close look at the source file:

  

  • The first line instructs the preprocessor. This is a piece of logic executed prior to the actual compilation, and it focuses on manipulating the C language, such as inserting other files or replacing macros with C code. It includes a header file called stdio.h. This file should be located in /usr/include/stdio.h, and contains definitions for several functions; in our case, we need it to let the compiler know that something called printf() exists.


  • Lines 3-6 consist of a block comment that will be ignored by the compiler -- everything between '/*' and '*/' will be ignored. It is clear that this comment can span multiple lines.


  • Line 7 defines the main entry point of our application. When the application is executed, it will start executing the function called main(); the int in front of it means that the main function should return an integer. The '()' means that main() is a function, and it takes no arguments (it can take arguments, but we will discuss this later).


  • Line 8 opens a block -- which is closed at line 12. These blocks group instructions which belong together; in this case they group the main() function instructions.


  • Line 9 is a single-line comment. When '//' is encountered on a line, what remains of that line is ignored by the compiler. It's impossible to end these comments, and they can not span multiple lines.


  • After 10 lines, we finally find something useful; here we call another function called printf(), and, between the parenthesis, we pass the function an argument, which, in our case, is a string literal. C strings are placed between double-quotes. Thus, we call the printf() function with a string as an argument. The only odd thing here is the '\n'; this is a so-called escape sequence, and it means nothing more than a newline. Try removing it, and you will see that when you execute the application, your prompt will be printed on the same line as the application. Note that every instruction ends with a semicolon. You will forget to place these semicolons on numerous occasions! This way, you can put multiple instructions on one line, or can have them span multiple lines.


  • Line 11 exits from the main function, and passes a certain value (in this case 0 -- which is of type int) back to whatever called this function. In this case, the shell called the main function. And that's why echo $? gave us our zero. This is an instruction, and thus also terminated with a semicolon.

  

  One final note is that, if you modify your source file, you should run gcc again. C is unlike Perl, Bash, Python, PHP, and others -- it's not an interpreted language; the gcc command calls a compiler (which transforms a higher level language into assembler), an assembler translates assembler into object files (machine instructions), and a linker, which combines several object files into an executable. These will transform the C code into machine code that your CPU is able to understand and execute.

  

  Exercises


  • Compile the example yourself, see that you can reproduce the result.


  • Make the application display Hello Ubuntu.


  • Replace return 0; by return 1;, and confirm that the exit status has changed.


  • Delete the return 1; statement, and check what the compiler says. Is it a warning or an error?


  • Run gcc without the -Werror parameter; does it create a binary now or not?


  • Remove the -o hello-world parameter at the command line. What is the default name given to the binary? Answer is shown below.


  • Try removing all comments from the source file, verify that this has no effect.


  • If you rename the main() function to foo(), what will the compiler (actually the linker) tell you?

  

  Answer: the default name is a.out

  

  Elie De Brauwer is a Belgian Linux fanatic, currently employed as an embedded software engineer with one of the world's leading satellite communications companies. Apart from spending time with his family, he enjoys playing with technology, and spends his days waiting for Blizzard to finally release Diablo III.


  

  



  How To

  Connect To IRC


  Written by Chris Lucier


  Internet Relay Chat (IRC) is a way of communicating online, in real-time, with other users grouped into networks. Networks have various channels for users to meet on. Inside a channel you can communicate with others, and even send files. This tutorial is a simple guide to getting started using IRC with the XChat (GNOME) and Konversation (KDE) applications.

  

  Both Xchat and Konversation are available through the standard Ubuntu repositories. To install them, use whichever package manager works best for you. For XChat you should be prompted to install both xchat and xchat-common (if for some reason you're not, be sure you get both). Also make sure you get xchat, not xchat-gnome, or this tutorial won't work.


  [image: ]


  When Xchat starts, you'll be presented with a Network List. Here you'll create your user name and some alternate user names (in case yours is already taken). You can then optionally enter your Real Name.
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  In Konversation, you will be presented with a Server List populated with one entry, which will take you to the Kubuntu IRC channel. Click 'New', then 'Edit', enter some Default Identity information, and click 'OK'.
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  We want to connect to the FreeNode network where we will find the Full Circle channel. To do this in Xchat, click on “FreeNode” in the Network List.
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  In Konversation, we need to add Freenode to our list of IRC servers - this is done by clicking the 'New' button in the Server List window and entering the Network name as 'Freenode'. Next, click the 'Add' button. For Server, enter irc.freenode.net, and for Port, enter 6667. And click 'OK'.

  

  Next, in Xchat, we enter in our channel name which is #fullcirclemagazine.
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  You can also view a list of all available channels within the server, but, for now, we'll stick to what we know.
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  While in the Konversation 'New Server' window, click the 'Add' button below the 'Auto Join Channels', enter #fullcirclemagazine, and click 'OK'. Click 'OK' again to close the 'New Server' window.
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  To join the Full Circle IRC channel, in Konversation, click on Freenode, and click the 'Connect' button.

  

  In Xchat, you will then see text that welcomes you to the FCM channel with a list of users, to the right, who are already there. Konversation uses a tabbed interface, so you may have to click the #fullcirclemagazine tab to see the chat channel.
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  This is where you now chat with everyone about whatever you wish. If your topic isn't being covered by the channel you are in, you can go to the menu and select Server > Join Channel (in Xchat), or File > Join Channel (in Konversation), to find another channel from the list. You should see your nickname at the bottom of the window with a box next to it. That box is where you'll be entering what you want to say, and any command you need to use.

  

  A really helpful IRC service to make use of is NickServ. NickServ allows you to register your nickname and protect it with a password. You may also link it to your email address. This prevents another user from using the same name as you.

  

  To set up your nickname using the NickServ service, open XChat (or your IRC client of choice) and enter:

  

  /msg NickServ REGISTER your_password your_email
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  If everything has gone correctly, you should see something similar to the image above. You'll also receive an email with a password to finish registering your nickname. Remember that passwords are case sensitive!

  

  This isn't the only function of NickServ. I won't go into further detail in this article, but you can find more info at http://www.technerd.net/nickserv.html

  

  To chat on an IRC channel, you just type what you want to say, and press 'Enter', like you would in an instant message application. You can also do special functions using commands. To get you started, here are a few useful commands and what they do:

  

  /me <type your message/action>
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  /nick <new nickname>
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  To send a private message to a user, use the '/msg' command followed by the nick of the user you wish to message, and then type whatever you wish to say - such as:

  

  /msg deicidist Hi deicidist! Can you help me with something?
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  Note that on freenode, you need to register your nick, and be Identified to NickServ to send private messages (see below for how to do that automatically). If you need help, you can use the '/help' command to get a list of useful commands to use in your IRC session. Simply type '/help' and press enter.

  

  When you're ready to leave, you can send a good-bye message to everyone by using the '/quit' command.

  

  /quit Bye everyone!
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  XChat offers you the option of automatically joining your favorite channel. For this example, we'll continue using the Full Circle channel. Click on the FreeNode network, and then click 'Edit'. Then, check the box next to 'Auto connect to this network at startup', then enter #fullcirclemagazine into the 'Channels to join' box. You'll also want to fill in your NickServ password - if you want to use your registered nickname on the channel when you join. By contrast, we already did this in the New Server window in Konversation.

  

  Click on 'Close'. You should be back at the network list window. You can check the box next to 'Skip network list on startup' if you like. This will let you go directly into the channel you're auto-joining - without being interrupted by this window. Click on 'Connect' when you're ready. Now, whenever you start XChat, you'll be brought right into the Full Circle channel with your registered nickname!

  

  If you have any trouble, feel free to post in the Full Circle forum at Ubuntu Forums: (http://ubuntuforums.org/forumdisplay.php?f=270). You can find me using the name deicidist on the forums, or the Full Circle IRC channel. See you there!

  

  Chris Lucier is a self-employed IT and computer consultant who goes by the aliases chris.lucier and deicidist on many forums. He does all his work on an ASUS Eee PC 701 (4G), and has been using Ubuntu since the release of 6.06.


  

  



  How To

  Using GIMP - Part 6


  Written by Ronnie Tucker


  This month, we move on to some more advanced features of GIMP. This group of features is primarily used in photographic touch-ups (also known as air-brushing) to either repair or enhance an image.

  

  Let's do the easy photo repair first - the infamous red-eye. This occurs when the camera's flash highlights the inside of the eyeball, causing the black pupil to look red.


  [image: ]


  The easy way to fix red-eye is to go to the Filters > Enhance > Red-Eye Removal menu. This will give you a preview of the image, and a threshold slider to fine-tune the red-eye removal.
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  But wait, it's altering parts of the image that aren't her pupils! This is because her lips are also red. Really, all that GIMP is doing is changing the red pixels to black. So, we need to be more selective with this image. Use the rectangular selection tool to draw a box around both her eyes; then try the Red-Eye Removal filter.
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  Much better. Just watch that you don't overdo the threshold slider lest you darken her reddish eyebrows.
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  Another way of doing red-eye removal is to simply create a new layer, draw a black dot for each pupil, and then multiply the dots layer with the original image until it looks good. But the Red-Eye Removal filter is a nice, quick, shortcut.
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  Our next volunteer is a celebrity who is, in this photo, looking a little bit 'worse for wear' let's say. Let's help her out; she needs to have those nasty spots removed.


  The Healing tool [image: ] will let you select a spot (no pun intended!) on the image to act as a reference point. GIMP will then give its best guess as to what should be under your brush - taking into account the reference spot. First, click the Healing tool icon. You'll see two crossed elastoplasts beside your pointer with a 'no entry' symbol (circle with a diagonal line through it). This means you have no reference point as yet. Hold down CTRL, and the 'no entry' symbol will vanish. Click somewhere near the blemish then release CTRL. You will now see a circle with a cross inside it marking your reference point.
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  Now, simply draw over the nearby blemish, and, if the reference point is good, the blemish will vanish. Sometimes you will need to undo what you did with the Healing tool, and try again, but trial-and-error is no bad thing.

  

  And, just like any good spot removal cream: apply as necessary:
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  Now our celeb is ready for the front page.
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  Before you start pointing fingers, no, that photo is not me! It's my grandfather, and the photo was taken in, roughly, 1930, so it's a bit tatty and needs some touching up.

  

  For this, we could easily use the Healing tool, but, this time, we will bring in the powerful Clone tool [image: ]. It will, like the Healing tool, need a reference point, but, this time, it will just clone the reference point to where your brush is - no guess work. So let's try it: same idea, you click the Clone tool, hold down CTRL, click on the source (near a crack in the photo), release CTRL, and you're ready to paint out the cracks.
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  And, just to prove a point, try the Healing tool on some photo cracks. It'll probably work just as well, but it's always better to have a Plan B!

  

  Next month, we will look further into Filters, drop shadows, blurring, smudging, and, the all important Layer Masks.

  

  Ronnie Tucker is Editor of Full Circle magazine, a proud Kubuntu user, and part-time artist whose gallery of work can be seen at www.RonnieTucker.co.uk.


  

  



  How To

  Scan And Convert To PDF


  Written by Irv Risch


  My problem was that I needed an old newsletter in PDF format to post on the Internet, but all I had was a hard copy. I tried this on my Windows machine, but finally gave up and fired up my Linux laptop.

  

  The first thing I needed to do was hook my scanner to my laptop. No problem, it just recognized it.

  

  At this point, I would like to say you can scan a document directly into Open-Office Write, but I have had issues with their “scan select source.” Everything is in millimeters instead of inches, and the only DPI options are 50 or 1200, so I do it just a little differently. You need the application “Xsane” - which is in the Repository. If you do not have it installed, then install it first. Go to menu and select Applications > Graphics > Xsane Image Scan. I have it set to open four windows (shown below).
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  1.Main Xsane Window (left)

  2.Histogram Window (top middle)

  3.Options Window (bottom)

  4.Preview Window (right)
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  In the main window, I set the Path, Type of file (JPEG), and Resolution (300). All the other settings I leave set at defaults.
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  In the Preview Window, I set the scan to full size, and then acquire a preview.

  

  After you obtain the preview (by clicking 'Acquire preview'), select the area you want scanned by moving the sizing lines in the preview window (see dotted line around scan image in above screen shot), then go to the main window and click the Scan button.
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  When your scan is done, it will open the viewer window and show you the finished scan.
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  Now, we must save this scan by going to the menu File > Save Image.
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  If you use the default file names, it will save them as page0001, page0002, etc. In my case, I needed 4 pages scanned. When I was done scanning, I just closed the viewer and main windows, and all the others closed also.

  

  Now, let us move on to converting them to one nice PDF document format. Select the Openoffice.org Word Processor from your menu. It will open with a blank document (right).
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  With the cursor at the top of the first page, go to the menu: Insert > Picture > From File.

  

  Select the file you want to insert and click Open.

  

  Placing the cursor on the start of the next page, repeat this process until you have all the scanned files in your OpenOffice document.

  

  Next, we want to export the complete document into a PDF format. We do this by going to the menu: File>Export as PDF.
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  When the next box opens up, take the defaults and select the “Export” button.

  

  A Save Document dialog box will open, so you can select where you want to save your finished document. It will be saved as a PDF-formatted document.


  [image: ]


  After closing your Open Office writer document, you can now do a preview of your finished work. Go to where you saved your file, and open it with a PDF document viewer.
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  This is what my finished product looks like in KPDF viewer.

  

  To finish my job, I opened up Firefox, ran the plugin FireFTP, and uploaded it to my Web server. If you would like to view it, it can be found at: http://wabasha-server.net/Outlook.pdf.


  



  Write For Full Circle


  Guidelines


  The single rule for an article is that it must somehow be linked to Ubuntu or one of its many derivatives - Kubuntu, Xubuntu,Lubuntu, etc.

  Write your article in whichever software you choose - I would recommend LibreOffice. But, please spell and grammar-check it!


  The Official Full Circle Style Guidecan be read at:


  http://url.fullcirclemagazine.org/75d471


  Please read this document before submitting an article. Follow the guidelines and you will have a much better chance of seeing your article in Full Circle.


  Writing


  There is no word limit for articles, but be advised that long articles may be split across several issues. In your article, please indicate where you would like a particular image to be. Please do not use any formatting in your document.


  Images


  Images should be no wider than 800 pixels, in JPG format, and use low compression.


  When you are ready to submit your article, please email it to: articles@fullcirclemagazine.org


  Non-English Writers


  If your native language is not English, don't worry. Write your article, and one of the proofreaders will read it for you and correct any grammatical or spelling errors. Not only are you helping the magazine and the community, but we'll help you with your English!


  FOR REVIEWS:


  Games/Applications


  When reviewing games/applications, please state clearly:


  
    	title of the game


    	who makes the game


    	is it free, or a paid download?


    	where to get it from (give download/homepage URL)


    	is it Linux native, or did you use Wine?


    	your marks out of five


    	a summary - with positive and negative points

  


  Hardware


  When reviewing hardware, please state clearly:


  
    	make and model of the hardware


    	what category would you put this hardware into?


    	any glitches that you had while using the hardware?


    	easy to get the hardware working in Linux?


    	did you have to use Windows drivers?


    	marks out of five


    	a summary - with positive and negative points

  


  You don't need to be an expert to write an article - write about the games, applications and hardware that you use every day.


  

  



  My Story

  ...When I Turned Two


  Written by David Rowell


  I'm a 71-year-old, retired, mechanical-aeronautical engineer, with Central New York roots, now living on the Florida 'Space Coast'. To put that age in perspective, Hitler invaded Poland on my second birthday. 1956 to 1959 were spent on the German border patrol with the 14th Cavalry. I have an AA in physics from Sierra College, and a physics BA from Syracuse University.
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  My first experience with computers was a FORTRAN programming course at SU in 1965. We punched our own cards (above right), and offered the deck to the computer gods - hoping to be favored with useful output. Ever consider what happens when you drop a program card deck? In 1967, Hewlett Packard invited me out to Palo Alto for a couple weeks to study the HP-2116 - a computer designed to operate in a factory or lab environment. At work, access to the GE Timesharing System using an ASR-33 Teletype machine was an opportunity to program using a really powerful BASIC superset – chiefly matrix manipulation commands. With these resources, we could code the tools that form the backbone of an engineer's job, saving time and making optimization easier.
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  Around 1970, Lipe clutch was designing a new test rig driven by a 1000+ horsepower aircraft engine. To address the significant sequencing and safety concerns, we installed a HP 2100 mini computer system (right) to monitor it. Our bleeding edge 2100 had 8k RAM, 75 c/s tape punch, 300 c/s tape reader, and a good old ASR-33 terminal. We programmed in Basic, Algol and FORTRAN with device drivers in assembler.
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  In the early '80s, I bought the kids a Commodore Vic 20. Reasons? It could be expanded, there was an assembler available, it had decent BASIC, and we could afford it. The kids taught the teachers computer skills, and were barred from the classes! The VIC (above) was followed by a couple of C-64s, and a C-128 (below).
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  More perspective – by the time we gave it away, I recall we had over $1000 in the fully expanded VIC system. At 14, my son had written a F79 Forth system for the VIC's MOS 6502 CPU, and I had developed application engineering tools.
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  In '84, I bought a TRS-80 Model 100 (above), the world's first successful notebook computer. The M100 had several neat features: 32k RAM, 2.4 MHz 80C85 CPU, a ROM slot, real printer and serial ports, but, best of all, it had a modem built-in. Hoo ha!! I could access CompuServe at 300 baud! We could exchange ideas and code with folks all around the world – folks we've never met nor ever would. Soon SuperROM was plugged into its belly, and I had a real word processor, spread sheet and outline processor. Oh, did I mention that it ran for weeks on 4 AA cells? I coded a FIG Forth system and wrote a few magazine articles about the M-100. My blower application software dramatically improved with the better BASIC. Sometime around '84, the Apple MAC was demonstrated - at a FORTH users group meeting of all places. Wow - real graphics, and the wonder of making things happen with a mouse! One of the members showed how overworked the 68000 CPU was by porting a FORTH system. It crawled and FORTH just doesn't do that! My son bought an Atari ST in '85 or '86. Before it came home, it was modified to 1 MB RAM - carefully soldered to the main board! Now we're talking color graphics, a mouse, and some serious speed. He took it to college with him where it died from a beer bath!

  

  The Commodores were followed by a succession of PCs of one sort or another, most home made (I like ASUS motherboards). If you haven't worked with CP/M, or one of the other early operating systems, it is hard to appreciate the immediate impact of DOS and the IBM PC. Even DOS 1 was far more forgiving than CP/M. DOS 2 was much more powerful than any alternatives. DOS, combined with open hardware architecture, was just what the business owner needed, and the blower application software just got better.
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  I tried Windows 2 (above) for a week or so on one of my 80386 machines - slow, clunky, what a kludge! Windows 3.1, on the other hand, was a real winner. When the price of a 40MB hard drive fell below $400, my son and I convinced Mama that we needed one – and, after a few days use, she agreed! Keep in mind that 40 MB was such a big drive that it had to be partitioned into two virtual drives to satisfy DOS/Windows 32 MB limitations. Soon, we would get a CD reader and Sound Blaster card for similar cost, and we were off and running in the “modern” world. Our games that, up to then, had been dominated by Zork and the like, could now have graphics and sound! Let's hear it for Kings Quest!
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  At some time around '94, IBM put on a whiz-bang demo of OS/2 Warp at the Syracuse PCUG. For the first time we saw the World Wide Web! Oh, the wonder of viewing pictures from the Louvre and other cool places! We just had to have it, and the special pricing made it reasonable. Yes, it was a better Windows than Windows. Yes, it did run DOS programs as well or better than Windows. No, it didn't like my printer. Yes, it was slow but man it was pretty.

  

  I recoded a NASA centrifugal compressor analysis program in Professional Basic – we didn't have a FORTRAN compiler at work. On my 10 MHz 80386/387 Windows 3 machine, I could start running a simple case, go brew a pot of coffee, and come back with a cup, generally before a run finished. On this box, it's done about the time my finger leaves the Enter key!

  

  I have fiddled with various Linux distributions since trying Red Hat and Mandrake in the late '90s. They installed, and I managed to get sound and my Zip drive working. But responsiveness was anything but zippy - so I reverted to DOS and Windows.

  

  At my grandson's urging, I installed Ubuntu 5.04, dual booting with XP, on my Compaq AMD Athlon XP box. I liked what I saw, and determined to learn and live with Linux, because I didn't look forward to Microsoft's version of the future.

  

  I see I made this post a few years back: “Unless the application picture changes radically I can't use Linux exclusively: Can't afford a good 2d/3d CAD to replace the CADKEY I have now. Can't find a genealogy program as good as what I have now (I have tried GRAMPS and it's OK but not as good as PAF5 or Ancestral Quest). I write and use design software in MS Prof Basic (works well under XP) and I don't see a good replacement under Linux (Yes, I've coded a few applications under GCC and it works well, but don't really want to change all this stuff). I think that GIMP will do everything that PaintShopPro will do, I'll have to work at it. All my CDs are on line as MP3 files; reformatting them would be a PIA. I'm not sure about viewing or editing video under Linux.”
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  Shortly after I made that post, Wine improved by leaps and bounds - allowing me to run the CAD system and genealogy programs. I discovered DOSBox, and Professional Basic loves it. I'm slowly coming to grips with GIMP, and, yes, it will do what needs to be done. The recent Full Circle Magazine series of articles sure helps. I discovered the “dirty” codecs which solved the MP3 and video problems. GRAMPS (above) had a major update, and recently yet another; now it's a hands-down winner. Someone suggested Avidemux as a simple video editor. It fills my needs. Update Manager is especially adept at keeping the system and all the software updated - updated in small increments rather than one huge 'service pack' that breaks so many applications. So, I'm happy as a clam with Ubuntu; it's stable, and I've found the software I need.

  

  Currently, Ubuntu's Hardy Heron serves me very well. Oh, my Windows XP is updated to SP3, but I don't use it except to handle my iRiver T-10. Someday I'll figure out how to deal with it under Ubuntu.

  

  I've had the opportunity to design and test quite a few centrifugal blowers for Hoffman Air Systems. My current (back burner) project is trying to write a centrifugal blower design cookbook with associated Fortran software, but it may never get past first draft! Of course, the blower software development uses the Linux Fortran tools, while Open Office handles the writing. When I need it, my old MS Professional Basic system runs very nicely on DOSBOX while CAD software runs on Wine.

  

  I've become the family historian since my daughter sweet-talked me into “helping” her. To organize our family data, we used Family Tree Maker for a while but dropped it in favor of Personal Ancestral File. The PAF database was converted to the more capable Linux program Gramps a few years ago. Last year, I scanned seven boxes of family pictures and documents using XSane Image Scanner. GThumb manages my pictures while the GIMP lets me “improve” them, and stitch multiple scans. Using some of that data, I managed to put together a list of Baldwinsville (NY) Academy graduates from 1870 until 1926 - including their spouses in most cases. That little Open Office generated PDF is in the library along with the source material. I've scanned the 1896 50th Anniversary Edition of the Baldwinsville Gazette and am slowly indexing it. If I ever finish that, I'll tackle the 100th Anniversary Edition.

  

  I'm active as maintenance officer in a local HAM radio group that has built a very complete emergency communication vehicle. To support teaching members about the vehicle, I've written a text using Open Office Writer. The group has been convinced to adopt OO as standard software; now to convert them to Linux!

  

  Several Windows programs run on Wine - I'm learning Morse code using G4FON's Koch Morse Trainer (below) - an old Print Artist supplies me with greeting cards - Flickr Uploadr gets pix online - PAF and Ancestral Quest let me help the genealogy community.


  [image: ]


  Everything isn't serious though. I like to play PySol or Mahjongg while I'm listening to music using Audacious (K.I.S.S.). I've ripped all my CDs to Ogg Vorbis format – byte for byte I think sound quality is best in that format. Planet Penguin Racer lets old Tux have some fun now and again. Frozen bubble is fun, but I get bored and quit somewhere above level 20.

  

  We've had something like 19 computers, including 6 notebooks, in the family since we bought that VIC-20 in the early '80s. At the moment, we have a Compaq AMD Athlon XP box running Windows XP and Ubuntu, an ASUS EeePC running an awful Xandros Linux, a Compaq notebook running 98SE, and a Toshiba notebook dual booting ME and Arch Linux with Xfce environment. There's a whole lot of good to say for Xfce especially on older hardware.


  

  



  My Opinion

  Is This The Year?


  Written by Robin Catling


  Bios: check

  

  Memory: check

  

  Reality: check?

  

  "Credit crunch!" Alter suddenly exclaimed.

  

  "What?" I said, putting down my teacake.

  

  "Licence fees!" Alter was clearly losing it.

  

  "Is this some sort of word game? Am I supposed to link the phrases together into a longer, less meaningful sentence?"

  

  "Consider, Professor - this year could be the best prospect yet as the year of Linux."

  

  You could hear the heavenly choir in his head as he said it. We've had this argument every year for at least ten years. Each time Alter mans the barricades of the Linux uprising, expecting to stick it to 'the man'. I'm still not sure who 'the man' is.

  

  "Think about it, Professor. With everyone tightening their belts - "

  

  "Money's too tight to mention..." I warbled, off key. Alter ignored me.

  

  "... no one wants to spend money on a Vista upgrade."

  

  "There wasn't exactly a rush before the Credit Crunch," I said sarcastically.

  

  "Your mortgage isn't sub-prime, Professor." This was rich coming from a tenant who pays no rent.

  

  "Anyhow, people aren't buying Vista because they're keeping XP."

  

  Alter assumed the pose with one eyebrow raised in condescension. It's his smug-shot.

  

  "I think there's a few million computer users would disagree with you, Professor."

  

  "Name me a hundred thousand or so."

  

  "All those people who've bought net-book computers this year. That's five million Asus Eee PCs, the Acer Aspire, Elonex One, Everex Green PC, MSI Wind - "

  

  At the mention of the Wind, I made a childish noise. Blame it on Blazing Saddles.

  

  "That would be five million Asus Eee PC's, but only two million running Linux."

  

  Alter wasn't impressed, but carried on.

  

  "- Dell selling Ubuntu with everything. It's what customers want."

  

  "It's what the Linux fan-boys on Ideastorm wanted, that's not the same thing, Alter. Most people don't care. That's why my friend Steve B in Redmond is making deals to keep XP working past its pension age."

  

  He's not really my friend. I met him only once. I'm still partially deaf in my left ear.

  

  "You - you!" Alter spluttered. "You made that podcast this year, you even called it Is this finally the year of Linux?"

  

  "I did. I also said - no, it isn't."

  

  "Your current client bought ten of the Asus Eee's as evaluation tools out of petty cash."

  

  "True. Then wiped most of them in order to load a custom build of XP."

  

  "Visibility, Professor. That's still millions of Linux desktops - Xandros on the Eee, that 'Cloud' thing on the Elonex. All – based – on - Linux!"

  

  Sometimes Alter reverts to his old Marxist revolutionary self. It's touching, really.

  

  "The people are beginning to realise you don't need all that bloat-ware to run basic desktop functions - email, web browsing, Office Writer. All those tiny, cheap Net-book machines are spearheading the Linux charge."

  

  "Hmmm. I can see the Linux share of the desktop market going up. Perhaps a whole half a percentage point. As long as India doesn't buy any computers this week."

  

  "Ha!" Alter scented victory. "India, Brazil, China. Come now, Professor. Millions of new users in the developing world, hardware cheaper than a second-hand Hum-Vee, running Linux with everything - even phones! Phones! Motorola already sold over nine million Linux-based handsets."

  

  "Windows Mobile 6," I countered.

  

  "Gahhghgh," Alter nearly choked.

  

  "Quite. But it's becoming ubiquitous - look it up. My current client switched to those HTC phones with Windows Mobile 6 and so did our main supplier. The operating system is bundled with the phone, not the other way round."

  

  Alter paused for breath. I pressed on.

  

  "Don't you dare mention God-awful Android and Open Milkshake -" I warned him. "Vapourware, all of it; like cheap claret. I won't hear of it in the house, I tell you."

  

  I had him out-flanked. Wellington would have been proud of me. Time for the coup-de-grace.

  

  "Even allowing for all those phones, all those netbooks, do you know what happens when their owners get home? They sit down in front of their desktop computers and those still have a Redmond logo on the front screen."

  

  I hated to drench his revolutionary fervour like this, but the old boy has to realise we're in this Linux thing for the long haul. Crushed, Alter still had to have the last word.

  

  "Can I get you some rat poison to go with your teacake, Professor?"

  

  Robin Catling occasionally earns money as a project manager, business analyst and technical trainer. He coaches fencing in the New Forest, Hampshire, England, and is completely, and utterly, barking mad.


  

  



  Review

  Linux Mint 5


  Written by Robin Catling
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    Although it's not one of the core Ubuntu distributions, we've given Mint a fair amount of coverage in the magazine this year: Mint 4.0 (Daryna) was Flavor of the Month in Issue #10, and was compared favorably to Ubuntu in Issue #11. Now that release 5.0 (Elyssa) is out, it's worth another quick look for the sake of three key things:

    

    • it's bang up to date


    • it's still pretty


    • it's really, really easy



    Before you say it's just another distro, bear in mind the hardware I've run it on:

    

    • Compaq Deskpro, Pentium 3 733MHz, 512mb memory, 20Gb disk, onboard Intel graphics.

    

    • Abit Pentium 4, 2.14GHz clone, 1Gb memory, Geforce-IV AGP graphics card.

    

    • Both trialled on a Belkin wireless USB dongle (spelled T-R-O-U-B-L-E in any Linux glossary).

    

    Elyssa freshly-minted

    

    Mint 5.0 is now based on Ubuntu 8.04 Hardy, which means that all the underlying code from the kernel to the utilities to the applications is the latest. This includes Gnome Desktop, Open Office, and Firefox 3.
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      The Mint (Live) CD uses the standard Ubuntu installer. Following the default steps of the install wizard works perfectly. Once you are up and running, the Mint Updater connects to the Mint repositories to bring everything up to date. The Updater (left) shows you what it's up to, and rates the packages on a scale of 1 to 5 according to importance and compatibility. The Updater icon (a padlock, strangely) resides in the Gnome panel.

      

      Elyssa, pretty as a picture

      

      I know it comes down to personal choice, but, if you don't like Ubuntu brown or Kubuntu blue, then the default Mint theme of green and black will come as a pleasant change. Mint includes the restricted drivers for NVidia and ATI cards (handled by Envy), which work well. I expected the graphics to be fairly shoddy on my elderly Compaq machine, but they were pin-sharp and (without 3-D effects) faster than I expected. If you don't like the theme, the Mint project thoughtfully provides a bookmark to its own version of gnome-look.org pre-filtered for the Mint distro. So, you can be confident that all the themes and engines work for Elyssa.

      

      The Mint main menu is laid out clearly, and wouldn't put off a newcomer used to a Windows Start Menu. Which brings us on to the last point...

      

      Elyssa, spelled e-a-s-y

      

      After two separate installations on old hardware, I haven't needed to use the command line. For me, this is a major triumph, as I got the Wireless USB dongle to work with no intervention. The Pentium-IV picked up native Linux drivers, and connected to the router from the get-go. The Compaq was a different matter. I've had no end of trouble with USB wireless adapters, mainly because they rely on using ndiswrapper with the Windows driver software that comes with the USB stick. I can spend hours messing around in a terminal trying to set these up - and I mean in current distros. Not in Elyssa. In the Mint menu, there's an entry for Wireless Windows Drivers (shown above). When I launched this on the Compaq, it suggested what driver to use with the chip-set detected. One click to accept, and the installer did the rest on its own. It just plain works. I know it's just a clever bit of scripting sitting on top of the networking provided in Ubuntu 8.04, but this comes as such a refreshing change - you wind up asking why all Linux distros don't have this.
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        Mint comes with most of the common multimedia codecs for music and video already installed. If there's more software you need, the Mint Installer (shortcut: "Software Portal" in the Mint Menu) offers a sort of Google search for a particular program. If found, it will take you to a website that lists and describes the package, and has an "Install Now" button. One click will download and install the appropriate file. You could say 'so what', but does the new Linux user want to rummage about in repositories or Synaptic?

        

        Top marks
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          Surprisingly, Mint feels quicker and smoother than a standard Ubuntu install on the same low-powered hardware. Give Mint to a Linux newcomer so that you won't need to spend hours explaining everything. The Mint bookmarks provided with Firefox are a great place to start. The Linux Mint Forums are a very friendly place to visit, second only to Ubuntu. Newcomers are made to feel very welcome. The Mint Blog and newsletter keep the community up to date. It's not going to replace my main Ubuntu 8.04 set-up yet (too many customizations in mine), but Mint 5.0 Elyssa is a usable, out-of-the-box, desktop distro. If the Mint team keep raising the bar like this, all other distros will have to take note. Then we'll all reap the benefits.


        

      

    

  


  MOTU Interview - Harald Sitter


  Taken from behind motu.wordpress.com
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  Age: 19

  Location: Austria, Europe, Earth, Solar System, Milky Way, Universe

  IRC Nick: apachelogger

  

  How long have you used Linux and what was your first distro?

  

  In 2003 I started off with Red Hat Linux 9, didn’t last for long though. I soon switched over to SUSE (9 I think), where I fell in love with KDE.

  

  How long have you been using Ubuntu?

  

  Since Breezy Badger - in dual boot with SUSE; since Dapper Drake - only Ubuntu.

  

  When did you get involved with the MOTU team and how?

  

  I think it was when I published my first package at kde-apps.org (didn’t even think about including it into Ubuntu). Following this, Raphaël Pinson asked me whether I actually want to contribute to Ubuntu and maintain the package there. I joined the Kubuntu tribe and started creating more packages.

  

  What helped you learn packaging and how Ubuntu teams work?

  

  The first package was done following a howto on ubuntuforums.org; later on, the almighty Ubuntu wiki and the Kubuntu crew (well, also a very well known web search engine).

  

  Favorite part of working with the MOTU?

  

  Everything. Really, since every part is having the higher goal of making (K)Ubuntu more usable, I really enjoy everything. Though, I guess, mostly it’s introducing hot new KDE/Qt software and helping new contributors to join Ubuntu development.

  

  Any advice for people wanting to help out MOTU?

  

  Poke me. More general though: never hesitate to ask.

  

  You have been working on a lot of different packages in the last cycles, what are you going to focus on in Hardy?

  

  Updates, sponsoring, and getting all the shiny new KDE 4 software into Universe *muhahahaha*

  

  How do you think Hardy will be special for our users?

  

  Well, Kubuntu Hardy is going to be the first release which ships with KDE 4.0 - I’m actually using it as kind of default since November, and can honestly say it totally rocks, even more than ponies! At the same time, we are providing KDE 3.5.8 - this makes Hardy most awesome because of two resulting advantages: those who want to check out 4.0 can do so, hence report bugs, hence improve whatever KDE 4.0.x is going to be shipped in Hardy+1; and those who just want a stable, reliable system can use 3.5.

  

  Favorite quote?

  

  Nothing is impossible. Not if you can imagine it. – Professor Hubert Farnsworth

  

  What do you do in your other spare time?

  

  Managing marketing/promotion, releases, and everything else within the Amarok project, as well as giving support on Amarok, Kubunu and KDE, and if there is any time left, sleep.


  

  



  Ubuntu Women


  Written by Cathy Malmrose
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  One of the most powerful ways to encourage women to join us in the Ubuntu environment is by making it more welcoming and normal for women to be here. One of the easiest and most effective ways to accomplish this is by amplifying the voices of the women already in the field.

  

  There are many highly talented women already in F/LOSS, many specializing in Ubuntu. One of the first women I met was Belinda Lopez. She immediately welcomed me and put me at ease. Every time I see her at a conference, she introduces me to a few new people, including Emma Jane Hogbin, one of the core Ubuntu Women.

  

  This year I had my own booth at LinuxWorld Expo 2008 in San Francisco. There were several opportunities to talk with Stormy Peters of the GNOME project, formerly of OpenLogic and HP. She is a big picture person, and I always learn something new from her. I said a quick "Hello again," to Emily from the Free Software Foundation. I met for the first time a lady named Kit, who works with Angela Brown of the Linux Foundation. Kit was spunky and charismatic.

  

  Typically, conferences are industry events where businesses rub shoulders, and booths are staffed with people who might not know much about the products they are showcasing. In contrast, most Linux conferences generate a sort of enthusiasm that makes me want to go back year after year. There is an automatic camaraderie that is natural at Linux events, even big showy ones like LinuxWorld Expo. It is easy to strike up a conversation with anyone there, because you can be relatively confident that everyone shares your same love for Linux. You also can be sure that nearly everyone there is passionate about their particular field of work.

  

  My final "hello" was with two notable women: Kat and Robin from Canonical. Simply seeing them on the show floor was a morale boost for me. They represented the type of professionalism that I hope will saturate the field over the next eight to ten years.


  

  



  Letters


  Two years ago a friend of mine threw a birthday party. As the party went on I couldn't help but glancing over at his father's computer monitor. I knew it wasn't a Mac, but I also knew that it definitely wasn't running Windows. Then I remembered reading an article on the Internet about Linux. Out of curiosity, I asked him: "Is that Linux?" I left the party with Debian, Knoppix, and MEPIS CD's.

  

  This past holiday season, I received a Dell Inspiron 1520 to replace my aging HP. Like most modern computers, it shipped with Windows Vista. For a while, everything was OK. Two months later, I decided that I had enough. Having reinstalled Vista three times and losing an entire library of ripped CDs in the process, I decided it was time for a change.


  So I backed everything up and dug out that old Debian CD. It had to be better than this. I was immediately intimidated by the installers lack of a GUI. Not knowing enough to continue the installation, I aborted at the partitioning step.



  Feeling discouraged, I turned to Google to see what I could find. My first encounter with Ubuntu was on Distrowatch.com It was on the top of the list, so I decided to check it out. Looking at screenshots and reviews got me really excited. I even read that Google used it internally.



  Hey, If Google uses it, it's gotta be good! During Winter recess, I decided to give Linux another go. I burned a copy of 7.10 and booted up. I had my fingers crossed as the installer's progress bar slowly crept forward. I was stunned that everything worked right out of the box. Vista needed three driver CDs to get basic networking going, but Ubuntu had wireless working right away. Ubuntu had everything I was looking for.



  Stability, security, and ease of installation. Now my whole family uses Ubuntu, even my little brother at nine years old. Thanks to the entire Ubuntu community, especially those who helped me those long winter days on Ubuntuforums.org.

  

  Travis Whitaker


  


  

  You cannot imagine how happy and thrilled I am to be able to learn, use, and tell other people about, Ubuntu. I first tried Kubuntu 6.06, but was not very successful with it. Now, I am using Ubuntu 8.04 as a Wubi inside Windows XP. I still cannot get over how much Ubuntu has improved since Kubuntu 6.06.

  

  One day, after I had been to my Chiropractor, I went to the local computer shop to browse. While I was there I started to talk with the sales-girl. She told me she had installed Ubuntu on a PC that she had built herself. Now, here is the crunch: she said that when she decides to build a Linux tower, she does the following: she gathers all the information that she requires, to enable a painless build of her tower, e.g. video cards, sound cards, etc. but only ones that are compatible to whatever distro she will be using. When she has all the required materials and information, she begins to build her tower. According to her, that is how she built her current Ubuntu tower.

  

  At the time, I was perusing the Asus EEE PC, I happened to have a copy of 'Ubuntu for Dummies'. The book itself was only slightly bigger then the Asus itself! I hope to purchase the 'Ubuntu Official Handbook' soon. In closing, I can only say, that when the manufacturers of printers, WiFi, etc. make it easier for Linux distros to be 'plug and play', we will see Windows left in the dust.

  

  Congratulations, and keep up the good work.

  

  Joseph Barr
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  On Saturday 23 of August 2008 I married my fiancée Elena. Here are pictures of our big day. Note the badge in my button hole: it is a badge with the Ubuntu logo. I preferred it to the usual paper, or real, flower.

  

  Sergei Agarkoff

  

  Ed: An excellent use for an Ubuntu badge, and congratulations to you both from all of us at Full Circle!


  


  

  I enjoyed the Gnome-Look guide in Issue 16, it's nice to see this summarized in one place. There was one bit of information missing though. The easiest way of installing Grub and Usplash screens is with a package called startupmanager. After it's installed there is a launcher in System > Administration > StartUp-Manager. Go to the Appearance tab and there you will see the controls to manage Grub and Usplash screens. There are of course manual ways of changing the Grub and Usplash screens, but the GUI startupmanager is a lot easier and faster.

  

  Mocha


  


  

  I am a teenager in the UK, I use Ubuntu 8.04, I really like your magazine as it helps me on a lot of my computing issues.

  

  One of the main attractions, however, was Ubuntu Youth. In the latest issue it was not there. Please can you tell me whether it is temporary (in which case I am OK with that) or permanent. If it is permanent then please undo this decision.

  

  Colm Murphy

  

  Ed: Fear not Colm, and other Ubuntu Youth fans. Ubuntu Youth wasn't in the last few issues due to Samuel having exams, and Andrew being busy cavorting with the stars at OSCON. It will return when Samuel is available again, honest!


  

  



  Q & A


  Written by Tommy Alsemgeest


  
    	Q With Rhythmbox, I am unable to edit any of the tags on my iPod or mp3 files. Any way to fix this?


    	A Can you change the tags with any other programs? You might want to try a different media player or organizer, such as Kaffeine. Also, check that your filetypes are actually mp3 and not a file which doesn't support tags.


    	



    	Q I have some issues with games in WINE. When I start a game, the screen divides into two workspaces with each of them showing identical pictures in horrible quality. I recently removed my video driver, so I installed fglrx, and, after reboot, the maximum resolution I can have is 800*600 with 75Hz refresh rate. The monitor's native is 1280*1024*75. My videocard is the Radeon X600.


    	A If you are using Hardy Heron, you should restart the computer, and if it has a countdown, press escape. From there, go into the recovery mode, and choose the option to repair the graphics, which should do it automatically. If that doesn't work, do the same thing again but this time go into the root terminal, and type:

    

    dpkg-reconfigure xserver-xorg

    

    That should do it.


    	



    	Q Everything works fine on my login account, but I set one up for my wife, and when I try to enable "extra", in the visual effects tab in her account, it says it cannot enable it. I'm using an Inspiron 6000 with Ubuntu 8.04.


    	A You might want to install compizconfig-settings-manager, and see if you can change any settings from there. Also, install fusion-icon, and try to launch Compiz from there. Both programs are in the repositories.


    	



    	Q I have problems getting my Sigmatel 92xx sound card to work. I get the test tones, but it looks as though Ubuntu does not support this card. What card should I get if I want sound in Ubuntu?


    	A Your sound should work. Don't buy anything until you have made sure it is a hardware problem. It may be a configuration problem. Try changing the sound-related settings in the menu. Since you get the test tones, I think it is a problem with the programs you are using. Go to the settings of the program, and change the sound settings there. Even if you do end up getting a new card, you can probably get one for about $20 (~£10). If you don't know how to install a card, you could get a usb sound device.


    	

    


  


  My Desktop
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  I've been a Linux user for 12 years. I started with Slackware and was using it for about five years, then Debian, and, for the last few years, I have been using Ubuntu.

  

  I work at one of the biggest IT companies in the world, and, of course, the employees are directed towards Microsoft products. Being a Java developer, and having almost all of my applications run in Debian servers, the need for Linux on the desktop was huge for me. So, when we all got new laptops at work, I decided to install Ubuntu on my new machine. Everything but the calendar (Exchange 2007) works in Linux applications. But instead of Exchange, I use my Google calendar in Lightning. At work I use a very basic desktop, as I need it to be fast and accessible.

  

  Gustav Ruthgård
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  I've been using Linux for approximately two years; just last year I found Ubuntu and fell in love with it. I've used Redflag, Ubuntu 7.10 and OpenSUSE. Now, I am using Ubuntu 8.04, and I find that it can solve almost any problem that comes up. I have customized my system using Google Gadgets and AWN. The theme I use is modified by me from the default Human theme, and the AWN theme (Curved Glassy Mint AWN). The sidebar is Google Gadgets, which you can get from the official Google website. I run a Tsinghua Tongfang T21 laptop, with a Celeron M 1.6GHz, 1GB of RAM, and an integrated video card with the resolution set to 1024x768.

  

  Mario Yuan


  

  



  Top 5 Email Notifiers


  Written by Andrew Min


  Mail Notification
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  http://www.nongnu.org/mailnotify/

  

  Mail Notification is a simple Gnome-based notifier that sits in your tray. It can check multiple inboxes, supports a bunch of formats including POP3, IMAP, Maildir, mbox, and mh, and even works with email clients like Evolution, Thunderbird, Gmail, Yahoo Mail, Hotmail, and Sylpheed. You can also configure it to play a sound, as well as open or mark as read the message. All in all, it's hard to ask for a more useful Gnome email checker.

  

  To install Mail Notification, grab the mail-notification package from the universe repositories.

  


  


  KBiff
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  http://www.granroth.org/kbiff/

  

  KBiff is to KDE what Mail Notification is to Gnome. Based on the famous command-line checker biff, KBiff is a powerful email checker that will run on your desktop (like xbiff), or in your Kicker tray. It supports POP3, IMAP, nntp, mh, maildir, and mbox; it has customizable icons; and it can run commands and play sounds when your message comes in. The only downside is that it's only available for KDE 3, not the new KDE 4, so it won't integrate as well, unlike Korn.

  

  You can install KBiff using the kbiff package in the universe repositories.

  


  


  Korn


  [image: ]


  http://www.ph.unimelb.edu.au/~ssk/kde/korn/

  

  If you think KBiff is too complicated, give Korn a try. Also based on biff, and named after the music group KoRn, this powerful email checker does everything KBiff does, but with much more ease of use. Protocols supported include DCOP, IMAP, KMail, mbox, nntp, process, and qmail. Unlike KBiff (previous page), it supports multiple accounts with just one instance. And the alert options let you hand configure whether you want to play a sound, show a popup, run a command, or change an animation.

  

  Korn is available in the Ubuntu repositories under the package name korn in the Universe repositories.

  


  


  CheckGmail


  [image: ]


  http://checkgmail.sourceforge.net/

  

  CheckGmail is the ultimate Gmail notifier. It has all the "normal" features, including running commands when new emails appear. But, since it's Gmail specific, it also has a lot of other handy Gmail-only features such as opening the messages, deleting them, batch deleting them, and archiving them - all without opening a browser. It can also be configured to check mail only for a certain label, and will work with Google Apps' Gmail. It'll even blink your LEDs (on an incoming message) if configured correctly.

  

  To install CheckGmail, use the checkgmail package in the Universe repositories.

  


  


  KGmailNotifier


  [image: ]


  http://www.kde-apps.org/content/show.php/KGmailNotifier?content=55375

  

  If you're a Gmail fan, but can't stand running a Gnome app like CheckGmail, KGmailNotifier is a great alternative. It's not quite as configurable as CheckGmail, but it features audio and LED notification, a handy pop-up for new mail, and support for opening the item in the browser of your choice. Like KBiff, the authors have not (unfortunately) gotten around to porting it to KDE 4, but it's still a handy tool.

  

  You can install KGmailNotifier using the kgmailnotifier package in the Universe repositories.

  

  Andrew Min has been a Linux addict since he first installed openSuSE in VMWare. Learn more about him at http://www.andrewmin.com/


  

  



  ﻿FULL CIRCLE NEEDS YOU!


  A magazine isn't a magazine without articles and Full Circle is no exception. We need your Opinions, Desktops and Stories. We also need Reviews (games, apps & hardware), How-To articles (on any K/X/Ubuntu subject) and any questions, or suggestions, you may have.


  We are always looking for new articles to include in Full Circle. For article guidelines, ideas, and for issue translation, please see our wiki:



  http://wiki.ubuntu.com/UbuntuMagazine


  Please email your articles to:

  articles@fullcirclemagazine.org


  If you would like to submit news, email it to:

  news@fullcirclemagazine.org


  Send your comments or Linux experiences to:

  letters@fullcirclemagazine.org


  Hardware/software reviews should be sent to:

  reviews@fullcirclemagazine.org


  Questions for Q&A should go to:

  questions@fullcirclemagazine.org


  Desktop screens should be emailed to:

  misc@fullcirclemagazine.org


  ... or you can visit our forum via:

  misc@fullcirclemagazine.org


  Full Circle Team:


  Editor - Ronnie Tucker -

  ronnie@fullcirclemagazine.org


  Webmaster - Rob Kerfia -

  admin@fullcirclemagazine.org


  Comms Mgr - Robert Clipsham -

  mrmonday@fullcirclemagazine.org


  Podcast - Robin Catling -

  podcast@fullcirclemagazine.org


  Editing & Proofreading:


  Mike Kennedy

  Lucas Westermann

  Gord Campbell


  Our thanks go out to Canonical, the many translation teams around the world and to Thorsten Wilms for the current Full Circle logo.
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